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COPYRIGHT NOTICE 
 
Reproduction or use of editorial or pictorial content of this software product and the documentation without the 
expressed written permission from MFJ Enterprises, Inc. is prohibited. 
 
While every precaution has been taken in the preparation of this instruction manual, the author and publisher assume 
no responsibility for error or omissions. 
 
Neither is any liability assumed for damages resulting from the use of the software or the information contained herein. 
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1.  Overview 
MFJCom for Windows is a software tool that simplifies the use of MFJ TNC. Instead of requiring 
you to memorize a large number of commands, all you need to do is "point and click" on easy-to-
use icons and buttons on the screen. MFJCom for Windows does all the rest for you. If you need 
to enter more information, MFJCom for Windows displays simple  "forms" for easy information 
entry.  
 
MFJCom for Windows can also be used for some other TNC-2 TNCs made by other companies. 
 
MFJCom for Windows lets you control your TNC in the way that's easiest for you: "point and 
click", or keystrokes. There's no need to use a mouse if you don't want to, but you can take full 
advantage of the Windows interface if you want. You can choose to have all controls displayed, 
ready for you to use, or you can have a clean, simple, uncluttered display if you want. 
 
MFJCom for Windows supports the following modes on your MFJ TNC: 

• Packet (HF and VHF) 
• Pactor  (FEC and ARQ modes)  on the MFJ 1276 or MFJ 1278 series. 
 

Packet mailbox mode can be used by directly entering TNC commands if you wish. 
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2. Installing MFJCom for Windows 
 
Installation is virtually the same in Windows 3.1 and Windows 95. 
 
To install MFJCom for Windows, simply do the following: 
 

1. Put the MFJCom for Windows “Setup” diskette in a floppy 
drive. 
 
2. If you are using Windows 3.1, make sure either the Program Manager or File Manager 

window is visible.  
 

• select "File"  from the menu bar at the top of the window  
• select "Run" from the File menu  
• enter:   a:setup      (or b:setup   if you put the diskette in drive b:) 
• press the "Enter" key 

     
   If you are using Windows 95, click on the “Start” button at the lower left of your screen. 

• select “Run” from the Start menu 
•  enter:   a:setup      (or b:setup   if you put the diskette in drive b:) 
• press the "Enter" key 

 
3. The "Setup" program will run. Simply follow the instructions on the screen. You can quit at 

any time while Setup is running if you wish. 
 

MFJCom for Windows shares some files with other Windows programs. When you are running 
the Setup program, you might get messages asking you if you want to replace a file on your 
computer with one from MFJCom for Windows. You should normally answer NO. This is 
because MFJCom for Windows can almost always use the file you already have, but other 
programs on your computer might not be able to use MFJCom’s. 
 

Note: you must run 
Setup from 

Windows. You can't 
run it from DOS 
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3. Running MFJCom for Windows 
 
In Windows 3.1, you can run MFJCom for Windows from Program Manager (the most common 
way), or from File Manager.   
 
In Windows 95, you can use Explorer, the Start menu, or drag the MFJCom for Windows icon (as 
a shortcut) to the desktop. 
 
The following sections tell you how to run MFJCom for Windows. 

3.1 Running From Program Manager (Windows 3.1) 
Double-click the MFJCom for Windows Icon from the MFJCom for Windows program group.  
(Note that you can move the MFJCom for Windows icon to another group if you wish. Consult 
your Windows manual for more information.) 

3.2 Running From File Manager( Windows 3.1) or Explorer (Windows95) 
Select the directory containing MFJCom for Windows (this is usually C:\MFJWIN, but you may 
have specified a different directory when you installed MFJCom for Windows). Double-click 
"MFJWIN.EXE". 

3.3 If This Is The First Time You’ve Run MFJCom for Windows... 
If this is the first time you’ve run this program, make sure that you have the “Setup” floppy 
disk in drive a: or drive b: of your PC (this is the floppy disk you used to install MFJCom for 

Windows). Make sure your floppy is not write protected. 
 
When you run MFJCom for Windows for the first time, you will see a screen asking you to enter your 
call sign. This is very important because many operating modes require your call sign in order to 
operate correctly. Your call sign will be copied onto the “Setup” floppy disk. 
 
If you do not have your “Setup” floppy disk in your PC, you will not be able to continue. 
 
You only need to have your “Setup” floppy disk in your PC the first time you run MFJCom for 
Windows.  After that, you will not need to have it in your PC. 

3.4 Software Control of the TNC: What to do if your TNC doesn't cooperate! 
The TNC uses "open loop" control. That means that when the TNC receives a command (from 
MFJCom for Windows, or from you), MFJCom for Windows has no way of knowing if the TNC 
actually responded correctly1. It also means that MFJCom for Windows can't tell if you sent a TNC 
control command directly from the keyboard (you could have gone so far as changing modes!).  
 
If you find that MFJCom for Windows does not respond to your commands, it may have gotten 
"out of sync" with the TNC. This does not happen often, but it is possible. If it does happen, you 
should: 
 -enter   "CONTROL-C"   from the keyboard 
 -enter the "ENTER" key 
 -select the desired mode from the Mode menu in the menu bar  

                                                           
1 There a several ways this could happen. For example, you may have an intermittent serial cable connection 
between your PC and TNC. Or, you may have turned the TNC off and on while MFJCom for Windows is 
operating. 
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  at the top of the window 

If that doesn’t work, enter the Command Key (normally  F3, but may be F1 depending on what you 
specified in the Setup Options) and repeat the above steps. 

 
This normally restores control to MFJCom for Windows. 

 

3.5 Serial (COM) Ports: What to do if your PC and TNC Don’t Communicate! 
When you first start up MFJCom for Windows, you might see this symbol at the bottom of your screen: 
 

 
Click on the button to get advice on possible ways  to resolve your problem. 
 
99% of the time, communications problems in Windows are due to conflicts between devices that use serial 
ports (your mouse, your modem, your serial port to your TNC, etc.). Even though these devices are connected 
to different ports, they can still ‘conflict’.   
 
If you are using “standard” IRQ (interrupt) settings on your serial port --most of us do--, check the following: 
 

If your TNC uses: then your mouse or 
modem should not use: 

COM1 COM3 
COM2 COM4 
COM3 COM1 
COM4 COM2 

 
This table is based on the fact that COM1 and COM3 normally share IRQ 4, and COM2 and COM4 normally 
share IRQ3.  
 
This sometimes can be restricting if you have more than two serial ports in use. One way around this is to 
setup a serial port with a non-standard IRQ. That usually requires changing a jumper on the serial card and 
setting some parameters in the “ports” section in the Windows Control Panel. If you do this, read your  serial 
port and Windows manual very carefully. Take care not to create other IRQ conflicts with devices like your 
sound card or printer port.  
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3.6 The MFJCom for Windows Main Window 
3.6.1 General Description 

When you run MFJCom for Windows, you will see the "main window". It looks much like this: 
 

 
 
Because you are using Windows, you will be able to switch to other Windows programs, re-size the 
MFJCom for Windows window, shrink the MFJCom for Windows window to an icon, and do 
anything else you can do in Windows.  
 
The MFJCom for Windows window has several important parts. They are: 
 
• the "Data From TNC" subwindow 

This window show the data received from you TNC. That data includes: 
 

• information received "off the air" 
• command responses from the TNC (i.e. what the TNC sends back in response to 

commands sent to it by MFJCom for Windows) 
 

The Data From TNC window stores the last 300 lines (approximately) of data received. You 
can scroll back by clicking on the scroll bar at the right side of the window. When new data 
is received, the Data From TNC window scrolls back to the last line. You can prevent this by 
clicking on the "Pause Screen" button on the lower left of the MFJCom for Windows 
window (see "Lower Tool Bar"). Data from the TNC will not cause scrolling when the Pause 
Screen button is checked.  Note: MFJCom for Windows will only store approximately the 
last 5000 characters received from the TNC when the Pause Screen button is checked. 
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• the "Keyboard Input" subwindow. 

This window echoes your keystrokes, and keeps a record of what you entered. It also 
echoes any data sent when calling CQ automatically, or when text ("brag")  or ASCII files 
are sent. 

 
• the "Upper Tool Bar" 

 

 
The Upper Tool Bar is located just above the Data From TNC window. You mostly use it to 
select operating modes, establish and break links (Pactor, Packet, Amtor), manage text 
"brag" files, and for printing and capture. 

 
• the "Lower Tool Bar" 
 

 
The Lower Tool Bar is located just below the Keyboard Input window. It has a variety of 
functions: control of the screen, time display, entry and sending of callsigns, as well as 
functions that depend on which mode you are in. 

 
3.6.2 Upper Tool Bar Description 

The functions of the Upper Tool Bar are described below: 
   

• "Data Capture" Check Boxes: 
 

These check boxes control capturing received data to the printer and/or 
the disk. Clicking on the appropriate box causes an 'x' to be displayed. That means the function 
is enabled. Clicking again on the box causes the function to be disabled, and the 'x' will 
disappear. 
 

• Operating Mode Buttons: 

              
 
The operating mode buttons are used to select the communication mode, and to enter the 
"setup" mode. If you are in “setup” mode, the mode buttons will appear like this: 

 
Operation of the “Custom Mode” button is described elsewhere in this manual. 
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The mode you are currently using is shown in two ways: 
 

• by the text in the main Title Bar at the top of the MFJCom for Windows window, and, 
• by the "mode" buttons in the tool bar at the top of the MFJCom for Windows window. 

 
You can easily change from one mode to another by clicking the mode buttons or by using 
menus. See Section 4. 

 
• Connect / Disconnect Buttons 

      
These are only displayed in Pactor, Packet and Amtor modes. 
 
When you are not connected (linked) to another station, the "Connect" button is displayed. 
Click on this button to try to connect to another station. A menu will appear to prompt you for 
more information. 
 
When you a connected, or attempting to connect, to another station, the "Disconnect" button 
will replace the Connect button on the toolbar. Click on the Disconnect button to disconnect 
("drop") the connection or to abandon an attempted connection. 
 

• Text "Brag file" Buttons 
The  3 Text buttons  are used to enter and send short files of text (up to 1500 
characters) that you create using MFJCom for Windows built-in editor.  Each 
mode (except Navtex and SSTV/Fax) has a different set of buttons. Graphics 
characters are supported in Packet and Pactor modes. 
 

• Send File Button 
The Send File button  is used send text from a file that you created with Notepad 
or some similar editor  Each mode (except Navtex and SSTV/Fax) has a text 
button. You can have as many ASCII files as you want. You would use this button 
for longer text files than you would with the  Text “Brag” files. 
Note that ASCII text with this button are sent just as if you had entered it from the 
keyboard. No ‘file transfer protocol’ is used. 

3.6.3 Lower Tool Bar Description 
The functions of the Lower Tool Bar are described below. 
• "Layout" button       

Click on this button to re-arrange the Keyboard Entry and Data from TNC 
windows. Each click will change to a different format: either overlapped, vertical tiled, or 
horizontal tiled (the default, startup, format). Click until you find the format that you prefer. 

 
• "Clear" button 

Click on this button to clear the screen. MFJCom for Windows will ask you to 
confirm this just to make sure you don't clear the screen by accident. 

 
• "Font/Color" button 

You can choose the colors and font for the Keyboard Input and Data from TNC 
subwindows by clicking the "font/color" button (alternately, you can use the "Screen" menu, 
and click on "color".  MFJCom for Windows will show the following form: 
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Simply click your color choice for each window. 
 
Click on “Change Font” to change the font. A menu will appear to let you choose a new font. 
Note: for best performance and to display ANSI graphics characters, you should choose the 
“Terminal” font. 
 
 Select OK to enable your choices, or Cancel if you do not wish to use your choices. 

 
• "Pause Screen" check box  

Click on this box to  temporarily stop new data from being displayed in the 
Data From TNC window. An 'x' will appear in the box when the screen is paused. Click again to 
display all characters received while the screen was paused and all new characters (the 'x' will 
disappear). Use this function when you want to scroll through the Data From TNC window and 
don't want the display to bounce around with incoming data. 

 
Note: MFJCom for Windows will only store approximately the last 5000 characters received 
from the TNC when the Pause Screen button is checked. 

 
• Time Display 

Local and UTC (GMT) times and dates are displayed. 
 
• Call Sign Transmission 

The "de (callsign)" button will send "de " followed by your callsign when 
clicked. 
 
The "Enter Call" button  will prompt you to enter a call in the button 
immediately to it’s right. You don't normally need to do this  in Pactor or 
Packet modes, since MFJCom for Windows can automatically determine the call of the 
station you are connecting or connected to. 

 
The callsign button will send the callsign that is displayed on it. If no callsign is displayed, 
nothing will be sent. If necessary, use the "Enter Call" button to enter and display a call 
sign. 
 

• Send / Receive Control 
Transmit, Receive, "Over"  buttons   

In some modes, a buttons will appear to alternated between transmitting and receiving 
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In Pactor, an "Over" button will appear instead which allows you to switch from sending 
to receiving. It will also enable you to "seize" the link from the other station if you wish. 

 
3.6.4 Menu Bar Description 

 

 
 

The menu bar is at the top of the MFJCom for Windows window. It allows you to perform almost 
all MFJCom for Windows functions with keystrokes instead of mouse clicks. Experienced users 
may find this a faster way to control MFJCom for Windows. To select a Menu bar item, either: 
 
 - click on it with the mouse,  
       or:    
        - hit the "ALT" key    
        - enter the underlined letter of the desired menu. The desired menu will be displayed.  
 
You can choose items from the menu by clicking on them or by using the ALT key / underlined 
character method described above. 
 

3.6.5 Hiding/Showing Toolbars 
The toolbars of MFJCom for Windows help make it easy to use, but they take up screen space. 
You can hide the toolbars to make more screen space available to 
you.  Simply click the Hide Toolbars button to make them disappear 
(the button will change to Show Toolbars). Almost all commands are 
available with menu commands so you can have full control over MFJCom for Windows even with 
the toolbars hidden. If you want the toolbars to reappear, simply click on the Show Toolbars button. 

3.6.6 Saving Screen Size 
Once you have adjusted the screen size to the way you like it, and have decided if you prefer the 
toolbars  to be visible or hidden, you can tell MFJCom for 
Windows to appear  the same way every time it is restarted. To do 
this, simply click the Save Size button.  
 
Note: the keyboard and TNC windows layout is not saved when you click the Save Size button. 

3.7 Setting Up MFJCom for Windows: Basic Information 
 

MFJCom for Windows needs some basic information for all modes of operation.  
 
Make sure you fill out the Basic Information form before using MFJCom for Windows. You can 
change the basic information any time you want later.  
 
You select the Basic Information Form by selecting the "Setup" mode (either by clicking the "Setup" 
button or by selecting it from the Mode menu. This will cause the Basic Information form to be 
displayed. The Basic Information form is shown below. Each entry is described later in this section. 
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• Call Sign: 

This field is mandatory.  
Make sure you include your portable designator, if applicable (e.g. VE3GLA/4). 
Do NOT include a packet "SSID" (e.g. don't use VE3GLA-15). That can be added with the 
packet forms. 
 
If you are not a ham, enter “SWL”, or something similar. 

 
• Name, City, State/Province/Region, Country: 

These are optional fields. You don't have to enter them. 
 

• Preferred time: 
MFJCom for Windows displays the time in both Local and UTC (GMT) modes. Click "Local" if 
you want local time to be shown in bold characters. Click "UTC" if you want UTC to be bold.   In 
order to display UTC time correctly, MFJCom for Windows needs to know how many hours 
your local time differs from UTC. Enter the data in the box. For example, USA Eastern 
Standard Time is 5 hours after UTC. If you live in a time zone that is 30 minutes off the hour 
(Newfoundland, Singapore, etc), then check the Adjust UTC by 30 Minutes box. 

 
• Preferred Startup Mode: 

You can specify which mode you will automatically enter after starting MFJCom for Windows. 
Simply click on the mode that you prefer. After MFJCom for Windows has started, you can 
easily change to other modes. 

 
• Radio Ports: 

Your HF and VHF radios are normally (but not always) connected to a different port at the back 
of your TNC.  
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Click on the port number for your HF and VHF radio. If you only have one radio, just click on 
the port number you are using for that radio. Check “radios must use different ports” if you want 
to ensure that the HF and VHF radios use different ports.  

 
• Computer Ports 

Your TNC is connected to your computer via a serial cable. You must specify what serial 
("COM") port that you are using in your computer. COM1 and COM2 are used most often. 

 
• PC to TNC Baud Rate 

Your TNC must communicate at the correct speed with your PC. Select the baud rate that your 
TNC is set for. You will have to click “OK”, exit MFJCom for Windows, then restart MFJCom 
for Windows to  ensure reliable communications between MFJCom for Windows and your 
TNC. 

 
• Which key is the “HELP” key 

Most Windows applications use “F1” to go to the Help menu. However, DOS MFJCom users 
may prefer to use “F3” for help. Select your preference. See section 4 for more details about 
function keys. 

 
• Show Tool Tips 

If you choose Show Tool Tips, you will see informative messages appear when you let the 
cursor pause over buttons or other controls on most screens. These messages can be very 
helpful when you are learning MFJCom for Windows.  Once you become familiar with this 
program, you may want to turn this option off. 
 

• Use/Cancel buttons 
Click on Use if you wish the form settings to be used. 
 
Click on Cancel if you want to use the previous settings to be used (i.e. cancel the changes 
you have made on the form). 

3.8 Function Keys: F1, F2 and F3 
Three keys on your keyboard are especially important: F1, F2 and F3. Through single keystrokes, 
you can: 

• access on-line “Help” 
• go to “converse mode”  (in packet modes only) 
• go to “command mode” for your TNC 

 
F1 is normally the ‘help’ key. If you press F1, you will enter the on-line help system, Use this 
function to look up techniques, tips, or answers to your questions. 
 
F2 is the “ converse” key. If you are in VHF or HF packet mode, just hit F2 and you will be in 
converse mode. Everything you type will be transmitted. 
 
F3 is normally the “command” key. Hit F3 and you will enter the TNC’s command mode. This is 
useful in packet to exit converse mode. It is also useful if your TNC gets into the wrong state for 
some reason. 
 
MFJCom for Windows lets you switch the meanings of F1 and F3. This allows F1 to have the 
same function as the DOS version of MFJCom.  You can switch meanings by using the Options 
menu in Setup mode (see chapter 3). 
 
The following table summarizes the three function keys uses: 
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Key Purpose (normal) Purpose (‘switched’) 
F1 access “Help” enter command mode 
F2 enter converse mode enter converse mode 
F3 enter command mode access “Help” 
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4. Selecting Modes of Operation 
The mode you are currently using is shown in two ways: 

 
• by the text in the main Title Bar at the top of the MFJCom for Windows window,  

 
and,    
 

• by the "mode" buttons in the tool bar at the top of the MFJCom for Windows window.  
 

The caption for the current mode is shown in light grey. You can easily change from one mode to another 
by pressing the mode buttons or from menus. 

 
Selecting modes: Mode Button method 

 

   
 

Press the button for the desired new mode from the tool bar at the top of the MFJCom for 
Windows window. 

 
Selecting modes: Menu method 

 
Either: 
 

• press:    ALT-M     
• press the letter for you desired mode, as shown in the mode menu 

      (e.g. "P” for pactor, "V" for vhf packet, etc.). 
 

Or: 
 

• click the "Mode" menu item from the menu bar at the top of the window 
• click the desired mode 

 
 

Please don’t switch modes by directly entering TNC mode change commands on the 
keyboard. If you do, MFJCom for Windows  will think the TNC is in a different mode than 
the TNC actually is in. In that case, MFJCom for Windows will probably display the wrong 
buttons and not behave the way you want.   
 
You should only switch modes using the Mode Button method or the Menu method. 
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5. Operating 
 

5.1 Pactor Operation 
 Note: Pactor operation requires the MFJ 1276 or MFJ 1278 series of 
TNC’s. 

5.1.1 Pactor Options 
 

Enter data in the following form to control Pactor operation in MFJCom for Windows. 
 

 
 
This form may be accessed while in Pactor mode either by: 
   -clicking the Options button at the top of the MFJCom for Windows window, or, 
   -selecting Options from the menu at the top of the MFJCom for Windows 
window. 
 
• FEC speed 

   -100 baud is slower, but may have fewer errors. 
   -200 baud is faster and is most useful under good signal conditions.  

 
• Reliability 

   -choose "normal" under average to good conditions 
   -choose "reliable" under poorer conditions. Transmission  speed will be slower,  
    but the other station will see fewer errors. 
   -choose "very reliable" under very poor conditions. Transmission speed  
    will be much slower, but you will have a better chance of being received with fewer errors. 

 
•  Speed    

Click on Automatic 100/200 normally.    
Click on 100 only when conditions are poor. This will reduce time wasted switching to 200 
baud. 

 
• Memory ARQ 

Memory ARQ is used by Pactor to combat errors induced by QRM and QRN by combining 
error packets to see if a valid one can be created. The parameters in this part of the form 
control how this is accomplished.  

NOTE: You can only transmit on 
frequencies and modes permitted 
by your license class. Be sure to 
observe all rules and regulations! 



Operating: Pactor 
 
 

 16

• "Go to 200 baud..."   
This number determines how many error-free 100 baud packets need to be received before 
going to 200 baud. If too small a number is entered, you may waste time going to 200 baud 
under poor conditions that may not support 200 baud. A number of 6  is suggested as a good 
starting value.  

 
• "Go to 100 baud.."    

This number determines how many bad 200 baud packets need to be received before going 
to 100 baud. If too small a number is entered, you may waste time going to 100 baud when 
occasional brief QRM or QRN occurs. If too large a number is used, you may spend too long 
a 200 baud when conditions may not support 200 baud A number of 6  is suggested as a 
good starting value.  

 
• "Use up to..."   

Pactor can combine a series of error packets to see if a good packet can be constructed. 
This can be very effective in getting data through in poor conditions. The number you enter 
here determines the maximum number of sequential error packets are used in this way. Too 
low a number will mean you don't get full benefit of this feature. Too high a number can also 
be bad under certain conditions. A starting value of 10 is suggested. 

 
• Connects   

Select Normal in almost all operating situations.  Select Long Path only when 
communicating with very distant (over 10,000 km) stations, and only when needed. 
 

• Use / Cancel  
 Click on Use to enable the changes you have made. Click on Cancel to ignore the change 

you have made. 
  

5.1.2 Pactor QSO's 
There are two different Pactor methods for QSO's. They are defined below, and are discussed in 
more detail in separate topics: 
 
•    FEC mode: 

FEC stands for Forward Error Correcting mode. Despite it's name, it is more prone to errors 
than ARQ mode. FEC is useful for short contacts, and for calling CQ in Pactor mode.  

 
Pactor FEC mode has different degrees of error correction available. With a high 
degree of correction, transmissions are slower, but the transmissions will have 
fewer errors. You can specify the amount of correction you want by clicking 
on the "Options"  button when you are in Pactor mode. 

 
•    ARQ mode: 

ARQ stands for Automatic Retry reQuest mode. In this mode, the TNC 
checks each group of characters received, and if an error is detected, the TNC automatically 
asks the characters to be re-sent to you until they are received correctly. Only then are the 
characters displayed on your screen. This mode will eliminate virtually 100% of errors. 
 
Most Pactor QSO's use the ARQ mode. 
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5.1.2.1 Pactor FEC Mode Operation 
You can listen to, and operate in both ARQ or FEC while in Pactor mode (this is different from 
the TNC's Amtor mode, which require a separate 'Listen' mode for copying ARQ 
transmissions). 
 
The actual speed of transmission is set in the Pactor Options form. 
 
To transmit in FEC mode, either click on the "send" button  at the lower right of the 
screen, or type  CONTROL-T. Your  transceiver will transmit, and the "send" button will 
change into a "receive" button .  Everything that you type will be transmitted. Characters will be 
echoed on the Data from TNC screen at the same speed as they are actually transmitted on the 
air. 
 
When you are done transmitting, either click on the "receive" button  or type 
CONTROL-R. The TNC will finish sending any data that has yet to be sent, then it 
will switch to receive, and the" receive" button will change to "transmit". 

5.1.2.2 Pactor ARQ Mode Operation 
You can listen to, and operate in both ARQ or FEC while in Pactor mode (this is different from 
the TNC's Amtor mode, which require a separate 'Listen' mode for copying ARQ 
transmissions). 
 
Another station can call you, and the TNC will automatically establish the link ('connection'). 
MFJCom for Windows will display the other station's call in a 'button' at the bottom of the 
screen. 
 
Alternatively, you can call another station to try to establish a link ('connection').To do 
this, simply click on the connect button  near the top of the screen (or select 
'Connect' from the menu bar).  A form will appear, and you merely enter the call sign 
of the station that you want to connect to. The TNC will try to establish the 
connection. The message "Connection Attempted" will be shown at the bottom of the 
window. If successful, the message "Connected" will be shown at the bottom of the 
window. If you are not successful, simply click on the 'Disconnect'   button at the top 
of the screen (it replaced the 'Connect' button). 

 
Only one station can transmit at a time. You can 'type ahead' while the other station 
is sending to you, and what you have entered will be transmitted as soon as it is your turn to 
send. After you have finished your transmission, you turn it over to the other station by doing 
either: 

   -clicking on the "over" button at the lower right of the window,  
 or 
   -entering  "CONTROL-R"  from the keyboard. 

 
When you have finished your QSO, either station can "break", or "drop" the link. If you wish to 
break the link, simply click on the "Disconnect" button at the top of the window, or select the 
"Disconnect" menu item. 

 
5.1.3 Calling CQ in Pactor 

 
You can call CQ once, or send a repeated CQ message. 

5.1.3.1 To call CQ a single time, or to Edit the CQ message: 
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• Click on this button,  
or    

• select 'CQ' from the menu bar at the top of the window,  
then    

• select 'CQ Once' from the CQ menu. 
 
This will cause the following form to be displayed. If you have already entered a CQ message, you 
will see it displayed. 
 

 
 
If you want to enter a CQ message. press Edit. 
 
Click 'Send' to transmit the CQ message. 

5.1.3.2 To Call CQ automatically more than once: 
• Click on this button,  

or   
• select 'CQ' from the menu bar at the top of the window,  

then   
• select 'CQ Once' from the CQ menu. 

 
This will cause the following form to be displayed: 
 

 
 
Enter the number of times you want CQ to be sent, and the time (in seconds) between calls. Note 
that the time interval is only approximate, so you may need to adjust it later. 
 
Calling CQ will stop automatically in Pactor mode when a connection is made. If you want ot stop 
calling CQ, click the "Stop CQ" button. 
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5.2 VHF and HF Packet Operation 
5.2.1 VHF and HF Packet Options 

There are separate menus for making your HF and VHF packet choices. The format of the forms is 
identical. The VHF packet form is shown below. The description of the choices that follows applies 
to both the HF and VHF packet forms.  
 
Click on the “Options” button in either VHF or HF packet mode to display this form ( it will look 
slightly different in HF packet and fewer options will be available): 
 

 
 
• SSID 

Sometimes you may wish to add a SSID (e.g. '-7') after your call. If you wish, select a SSID 
number  (0 to 15). Otherwise, select None.  

 
• TX Delay 

To enter the delay required for your rig to switch from receive to transmit, simply click on the 
appropriate value. 

 
• Connect Text 

Click 'Yes' and enter a message if you want your TNC to send a message automatically when 
someone connects with you. 

 
• Beacon Text 

Click "Yes" if you want to send a beacon, and enter the message to be sent. Click on the 
interval between beacon messages. PLEASE don't send beacons unless you have a really 
good reason to! 

 
• Maximum Number of Retries Allowed Before Disconnecting 
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When a TNC has trouble sending a packet because of interference or poor propagation, it re-
sends the packet. This is called a ‘retry’. If conditions are very poor, it is possible for the TNC to 
retry excessively and still get little or no data through. This situation only increases channel 
congestion, and serves no real purpose.  
 
This option lets you limit the number of retries in a row before your TNC gives up and 
disconnects. You can also allow an infinite number of retries, but this is normally not a good 
idea. 
  

• Allow Digipeating 
Click "Yes" if you want to allow others to digipeat through your station. PLEASE don't allow 
digipeating on HF packet! It is inefficient on that mode, and only contributes to extra QRM. 
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5.2.2 VHF and HF Packet QSO’s 
• General 

VHF and HF Packet operation with MFJCom for Windows is essentially identical. First you 
must have set up your 'choices' for the packet mode (VHF or HF) that you are using. You only 
need to do that once, but you can change your choices at any time if you want. 

 
• Establishing and Breaking Connections 

(Only use this procedure to make connections directly to a station or a node. Do Not use this 
method to connect from one node to another. Use the keyboard to enter the commands that 
the node needs) 

 
   Establishing a Connection 

Either (your choice): 
   -click on the Connect button  on the upper tool bar,   
or.. 
   -select Connect from the Menu bar. 
 
A form will appear, asking for the call of the station you wish to connect to.  
 

 
 

Enter the call, click ‘OK (call this station)’ and MFJCom for Windows will attempt to 
make the connection. If you are unsuccessful in making a connection, follow the 
"Breaking a Connection" procedure. 

 
 

   Breaking a Connection 
 

Either (your choice): 
   -click on the Disconnect button  on the upper tool bar,   
or.. 
   -select Disconnect from the Menu bar. 

 
• Auto Router (VHF Packet Only) 
 

MFJCom for Windows 'Auto Router' capability makes it very easy  to make VHF packet 
connections through nodes to other packet stations and BBS's. With Auto Router, you can tell 
MFJCom for Windows which nodes you need to use. MFJCom for Windows will remember 
the paths, and from then on, all you need to do is 'click' on the desired path. 
 
Up to 4 different routes, each with up to 4 'steps' can be specified. 
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To use this feature, first select "Connect" from the main tool bar. The following window will 
appear: 

 
 

Click on the "Use Auto Router...." button to use the Auto Router feature. A form similar to the 
one below will appear: 
 

 
 
Click on the "path" button for the path you want to use. In the form above, path 1 is selected. 
You can choose any of 4 paths. 
 
You can enter a description of the path you are setting up, to help you remember what it is for. 
In this example, this is the path from the author's QTH to a local BBS. 
 
You can enter up to 4 connections to reach your final destination. In this example, 2 
connections are used to reach the BBS. The first connection is to VE3KSR. Once connected to 
VE3KSR, the second connection is to BBSRWP (the final destination).  Enter the connections 
that you want. 
 
Because making connections through nodes can be time consuming, you should specify the 
maximum time you will allow for each connection in the box in the form. If a connection does 
not occur in time, the connection process will be stopped. 



Operating: Packet 
 
 

 23

 
When you have finished specifying the connections, click on "Connect". MFJCom for 
Windows will begin making the connections. MFJCom for Windows will also remember what 
you entered, so you won't have to re-enter the data next time.   If you don't want to make the 
connection, click on "Cancel". 
 
 

• BBS and DX PacketCluster Menus 
 

MFJCom for Windows provides two menus that you can optionally display to help you use 
basic BBS and PacketCluster functions.  
 
To enable a menu, simply click on the appropriate button in the lower toolbar.  

        
To turn a menu off, click on the button again, and the menu will disappear.  They will also 
disappear if you click the “disconnect” button at the top of the screen, or if you change modes. 
 
These menus are useful primarily to new or infrequent users and will reduce the need to 
memorize BBS commands. Because there is a wide variety of BBS's in use, these menus may 
not work in all situations. 
 
The menus are in the form of “tool bars” that appear near the top of the screen. You can select 
either, or both, toolbars to appear. 
 
The BBS Menu toolbar looks like this: 

 
The DX Cluster Menu toolbar looks like this: 

 
The BBS Menu toolbar buttons letters are black and the DX Cluster Menu toolbar buttons are 
blue. That helps you to tell them apart when they are both displayed. 
 
Remember, you can always use keyboard commands if you prefer when you are using BBS’s 
and DX Cluster nodes. 
 

•  Packet Defaults 
 

MFJCom for Windows sets the following defaults for VHF and HF Packet. In general, these 
follow the suggestions in the TNC manual. You can temporarily change these defaults by doing 
the following: 
 
   -enter CONTROL-C from the keyboard   
   -enter the parameter you wish in the format described in the TNC manual.  

. 
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VHF Packet Defaults: HF Packet Defaults: 
 

NULLS 0 
NEWMODE ON 
CONMODE C 
MONITOR ON 
DELETE OFF 
CR ON 
PACTIME OFF 
PACLEN 128 
DWAIT 16 
UNPROTO CQ 
NUCR OFF 
NULF OFF 
AUTOLF ON 
AX25L2V2 ON 
RESPTIME 0 
ACKPRIOR ON 
DEADTIME 33 
MAXFRAME 4 
FRACK 3 
ACKTIME 13 
SLOTS 4 
RETRY 0 
DAYUSA ON 

 
NULLS 0 
MONITOR ON 
DELETE OFF 
CR ON 
CPACTIME OFF 
PACLEN 32 
DWAIT 0 
UNPROTO CQ 
NUCR OFF 
NULF OFF 
AUTOLF ON 
AX25L2V2 OFF 
RESPTIME 0 
ACKPRIOR ON 
DEADTIME 33 
MAXFRAME 1 
FRACK 8 
ACKTIME 13 
SLOTS 4 
CHECK 0 
RETRY 0 
DAYUSA ON 

 
 

5.2.3 YAPP File Transfers 
YAPP (“Yet Another Packet Protocol”) is a method of transferring “binary” files in packet. Using the 
YAPP features of MFJCom for Windows, you can: 

• send files to other stations 
• receive files from other stations 

  
To use YAPP file transfer, you must be connected to another station and that station must be able 
to use the YAPP protocol. 

5.2.3.1 Starting YAPP 
When you are connected, you will see a Picture and File transfer button at the top toolbar (it 
is only visible when you are in VHF Packet mode and are connected to another station).  Click 
on the  Picture and File transfer button. You will see the following form appear: 
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5.2.3.2 Sending YAPP Files 
You need to tell the other station that you want to send a file before proceeding before entering 
YAPP mode.  
 
Next, enter YAPP mode. 
 
Click on the “Upload (send) a FILE” button.  MFJCom for Windows will ask you for the name 
of the file to send. Select the desired file, and click “OK”. 
 
The file transfer will begin. A progress bar will soon appear showing you how much has been 
sent to the TNC. NOTE that the TNC may not have actually transmitted that much .... the 
channel activity, signal strength and other factors can mean that less than this has actually 
been transmitted. This is normal.  
 
You will also see some information about the “state” of the transfer. This is normal, but not 
really important. 
 
Usually everything goes smoothly. However, occasionally either station can get out of sync. If 
you think this has happened, simply cancel and try again. 

5.2.3.3 Receiving YAPP Files 
You need to tell the other station that you want to receive a file before proceeding before 
entering YAPP mode. 
 
Enter YAPP mode. 
 
Normally, you will want to save the received file with the same name that it has at the other 
station. However, if you want to save it with a different name, click “Use File Name Selected 
by YOU”. You will be prompted to enter a file name. 
 
Click OK when you are ready to receive. A progress bar will show you how much of the file has 
been received. 
 
You will also see some information about the “state” of the transfer. This is normal, but not 
really important. 
 
Usually everything goes smoothly. However, occasionally either station can get out of sync. If 
you think this has happened, simply cancel and try again. 

 

5.2.4 Packet Images for Windows 

5.2.4.1 General 
Packet Images is a new feature that allows you to send and receive images with other packet 
stations that use MFJCom for Windows. You can create and modify images with many 
different software packages.  
 
MFJCom for Windows displays images line-by-line during reception. You do not have to wait 
for a whole image to be received before it is displayed. 
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You can even display pictures as they are being received from stations that do not use 
MFJCom for Windows! (those stations cannot display images that you send to them while the 
image is being received, however. Tell them to get MFJCom for Windows!) 

5.2.4.2 Packet Images is not the same as Packet Pix in DOS MFJCom 
MFJCom for Windows uses a different method of transmitting and receiving pictures than 
MFJCom for DOS does.   
 
MFJCom for Windows uses the standard uncompressed and compressed “BMP” image file 
format. You can create such files with many software packages including the ones included 
with Windows 3.1 and Windows 95. Because of this, you can even display images as they are 
being received from stations that are not using MFJCom for Windows.  
 
Unfortunately, MFJCom for DOS does not use standard “BMP” format. This means MFJCom 
for DOS cannot receive images from MFJCom for Windows. 

5.2.4.3 Image Format 
Packet Images uses the Windows standard “BMP” files that many software packages create. 
You can use those packages to create images that you want to send, or to view and modify 
ones that you have received. Best performance occurs when using compressed BMP images 
(sometimes called “RLE” images). 
 
Packet Images cannot display images in other formats, such as TIFF, JPEG, PCX, etc. 

5.2.4.4 Compressed and Non-compressed images 
Images take a lot of bytes. The number of bytes depends on the amount of detail in the image 
and the image’s overall height and width.  By using  “compression”, you can store many images 
with fewer bytes. Compression can also significantly reduce the amount of time it takes to 
transmit an image:  this reduces the amount of traffic on a packet channel, and makes this 
mode more enjoyable. 
 
Some software packages can create compressed “BMP” files. The exact method of 
compression is an industry standard. One shareware package that does this is “WINJPEG”.  
WINJPEG is available from many on-line services or from companies that distribute shareware.  
MFJCom for Windows can also compress images for you before you transmit them (see “How 
to Use Packet Images” for more detail). 
 
However, you are not forced to use compression. MFJCom for Windows automatically detects 
whether or not an image is compressed, and displays the image correctly. 
 
Note that you  cannot use compression schemes such as “ZIP” or “ARJ” if you want to display 
images while they are being received. 

5.2.4.5 How to Use Packet Images 
The instructions that follow assume that you are already connected to another station and that 
station is also using MFJCom for Windows. 

5.2.4.5.1 Sending Packet Images 
Tell the other station that you are going to send him / her a packet image. The other station 
must use MFJCom for Windows to display your image while it is being transmitted. That 
station should follow the “Receiving Packet Image” steps described in the following section. 
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Do the following steps: 

 
1. Click on the Image / File transfer button on the toolbar (this button is only visible when you 

have established a VHF packet connection with another station; it is invisible all other 
times).  The YAPP transfer form will appear on your screen. 

  
2. Click the button to indicate that you are sending a picture. Do either step (a) or step (b) 

below 
  

• Step (a): Send the Image 
 If you know the file name of the image file that you want to send, simply click the 

OK button. MFJCom for Windows will ask you for the file name, and will then show 
you the image. If that is the image you want to send, click “Yes”. If you accidentally 
chose the wrong image, or you have changed your mind, click “No”.  MFJCom will 
then use the YAPP protocol to transmit your image to the other station. 

  
• Step (b): View and Compress an Image before Sending 

If you do not know the file name, or if you want to compress an image before 
sending it, click the “View/Compress” button. MFJCom will ask you for the file 
name (it will assume you want to look at “BMP” images, but you can ask it to look 
for other types). It will display your chosen image. Click “Yes” if you want to 
compress the file, or “No” if you do not. 
 
If you compress a file, it will give the compressed file the same name as the 
original “BMP” file, but will give it the extension “.RLE”. For example, if your image 
file was called” 
 
 myimage.bmp 
 
MFJCom for Windows will call the compressed file 
 
 myimage.rle 
 
You will see the following progress bar as compression takes place: 
 

 
 

After compression is complete, you can go to Step (a) to proceed with transmitting 
the image. 

 
The image may take a long time to send. The amount of time depends on the file size, the 
quality of the link, and the amount of activity on the channel. 

5.2.4.5.2 Receiving Packet Images 
You need to know that the other station is sending you a Packet Image. 
 
Click on the Image / File transfer button on the toolbar (it is only visible when you have 
established a VHF packet connection with another station; it is invisible all other times). 
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A form will appear. Click on the button to indicate that you are going to receive a picture.  
 
Because images are really data files, MFJCom for Windows automatically stores a copy of 
the image for you. Normally you will use the file name that the other user has given his/her 
image. However, you can indicate that you want to use a file name that you select if you 
want. If you select this option, MFJCom for Windows prompts you for a file name. 
 
Click on OK. Image reception will begin when the other station begins sending it to you 
using the YAPP protocol. 
 
Everything is automatic from that point on.  A blank window will appear where the image 
will be displayed. You will see a series of messages at the top of that window, indicating 
the progress of the image exchange. These progress steps are: 
 

1. “Getting Ready”.   The file name, file size, and certain information about the image is 
being received.  The size of the image form may change to accommodate the height 
and width of the image. No image is displayed at this point. If MFJCom for Windows 
determines that the image is not in BMP or RLE format, it will attempt to halt 
reception. 

  
2. “Receiving Color Map”. About 1000 bytes of color information is received. No image 

is displayed at this point. 
  
3. “Receiving Image”. The image is displayed as it is received. The image begins at 

the lower left corner of the form, and displays from bottom to top. 
 
Note that you can move the image form around the screen with your mouse. 
 
The image may take a long time to receive. The amount of time depends on the file size, 
the quality of the link, and the amount of activity on the channel. 
 
The progress of the transfer is shown in the YAPP screen that is also visible. 

 

5.2.4.5.3 How to Receive and Display Pictures from Users of Other Software Packages 
 

Packet Images uses the amateur de-facto standard YAPP protocol to exchange images. 
That means that you can easily display images from any station that sends you a picture 
with YAPP. Here’s what you do (assuming you have already made a connection with 
another station): 
 

1. ask the other station to send you a picture in BMP (preferably compressed) file  
format. 

2. the other station should start sending you the picture file with YAPP 
3. you simply follow the same Image Reception procedure described in “How to Use 

Packet Images”. 
 
That’s all there is to it! 
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6. Time Saving Tips 

6.1 Sending an Identification Message 
You can quickly send identification messages like:     
  hiscall  de yourcall 
 
For example, if the other station is K1XYZ and your call is W9ABC, then the identification message 
would be:        
  K1XYZ de W9ABC 
 
The other station's call must be displayed in the button beside the "Enter Call" button. That 
happens automatically when a Pactor or Packet connect occurs. In other modes, you should click 
on the "Enter Call" button to enter the other station's call into the appropriate button. 
 
You can send an identification message in either of two ways: 
• Mouse method 
             Click on:    
  (1)  the other stations call sign button in the lower right of the screen    
  (2)  the  "de yourcall" button in the lower right of the screen. 
 
• Keyboard method 

From the File menu, select the Send Id item.  
The shortcut way is to enter:    ALT-F  then   I 

 

6.2 Sending the other station's Callsign 
You can type the other station's call, of course, from the keyboard. You can save keystrokes, 
though, by using some built-in features of MFJCom for Windows. 
 
The other station's call must be displayed in the button beside the "Enter Call" button. That 
happens automatically when a Pactor or Packet connect occurs. In other modes, you should click 
on the "Enter Call" button to enter the other station's call into the appropriate button. 
 
You can send the other station's callsign in one of two ways: 
 

Mouse Method 
Click on the other stations call sign button in the lower right of the screen. 
 

Keyboard Method 
From the File menu, select the Send Callsign item.  
 
The shortcut way is to enter:    ALT-F  then   C 
 

6.3 Sending Your Callsign 
 
You can type your callsign, of course, from the keyboard. However, you can save keystrokes by 
using some built-in features of MFJCom for Windows. Your callsign is displayed in a  button near 
the bottom right corner of the screen.. You can send "de your callsign" in one of two ways: 
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• Mouse method 

Click on  your call sign button in the lower right of the screen 
 
• Keyboard method 

From the File menu, select the Send Callsign item.  
 
The shortcut way to do so is to enter:    ALT-F  then   C 

6.4 Using Text ("Brag") Files 
Each operating mode can have 3 different files (sometimes called 'brag" files) that the user 
can edit and transmit whenever needed. MFJCom for Windows has a simple editor to 
help create those files. This editor can even handle graphics characters for operating 
modes that can use graphics characters (Pactor and Packet).In each operating mode, you 
will see 3 text file buttons at the top of the screen that look like this:  

 
Underneath each button is a title that you can specify. There are different file buttons for each 
different operating. 
 
You need to know two things to use text files:   
  (1) how to edit them, and  
  (2) how to transmit them. 
 
Click on the button for the file you want to edit, or select the file number from the "Edit" menu. This 
will cause the following form to be displayed: 
 

 
 
If there is already data in the file, it will be displayed in the window.   
 
Click on "Edit" to  edit the file, or "Send" to transmit the file.  
 
If you decide to do nothing, then click on  "Cancel" or use the Escape key. 
 

• Editing Text Files 
MFJCom for Windows will display a form with a large edit area at the top. It will look something 
like first picture on the following page:  



Time Saving Tips 
 
 

 31

 
 
You can type in data just like any text editor.  
 
You can cut and paste to other text files using the Edit menu 
 
Click on the "Clear" button to clear the screen if you wish. 
 
At the bottom of the form, you will see an array of graphics characters. To insert a graphics 
character into your text file, simply:    
 
  -click to the point in the file where you want the character to go,  
then..    
  -click on the graphics characters(s) you want to go into the file.  
 
To make it easy to remember what is in your file, enter a "caption", or title, in the box at the bottom 
right of the form. This caption will be displayed under the appropriate file button on the main 
MFJCom for Windows screen. 
 
When you are done, click on the "Use and Save" button. 
 
If you decide to discard what you have entered, simply click on the "Cancel" button.  
 

• Transmitting Text Files 
The "Send" button will cause the file to be transmitted. You will see the characters in the file appear 
in the Keyboard Input window, just as if you typed them from the keyboard. 
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6.5 Using ASCII Files 
In addition to Text (“brag”) file, MFJCom for Windows lets you send text files that you have created 
with a text editor.  
 
Text files must be in pure “ASCII” format. Windows Notepad is one tool for creating ASCII files. You 
can also use many word processors but you must be sure that you save files in “text” 
format. 
 
To send an ASCII file, click on this button: 

 
MFJCom for Windows will show a menu to select the file name that you want to send. Select your 
file, and click OK.  The file will be sent for you. 
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7. Printing 
 
You can have MFJCom for Windows print everything that is received from the TNC. Use either of 
the following methods to turn the printer On or Off: 
 

• Mouse method 
Click on the "Print"  check box near the upper left of the MFJCom for Windows window. This 
will start capturing printer data. Repeating this will cause capture of printer data to stop. 

• Keyboard method 
Select the file menu by entering  "ALT-F”. Then, select the Capture to Printer function by typing  
"P".(You can also use the mouse to select these menu items) This will start capturing printer 
Data. Repeating this will cause capture of printer data to stop. 

 
The following form will appear: 
 

 
 

If you choose "Print via Windows", all data from the TNC is then captured for printing. 
MFJCom for Windows uses the printing capabilities of Windows. All print lines will be saved, 
and are not printed immediately. To have your printer actually print the captured information, 
you can either:  

 
      ..stop capture to printer,   
                       or,       
      ..click on the "Feed" button near the "Print" check box. 
 

If you choose "Print Directly to Printer", MFJCom for Windows will send data directly to the 
parallel printer port (only LPT1 is supported). This will only work if your printer can directly print 
ASCII characters. PostScript printers will not work in this mode. 
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8. Capture to Disk 
You can save data from the TNC window in a disk file for later use. To do this, use either of the 
following methods: 
 

• Mouse Method 
Click on the "File capture" check box near the upper left part of the screen.(Repeating this step 
will cause capturing to disk to stop.) 

 
• Keyboard Method 

Select the "File" menu by entering "ALT-F". 
 
Select the "Capture to File" item by entering "F".(Repeating this step will cause capturing to 
disk to stop.) 

 
A form will appear which will allow you to select a name for the file to be saved (the file names 
will be different on your computer):  
 

 
 

MFJCom for Windows will suggest the following name: 
     SRyymmdd.SKY 
 
where:          
  yy    is the  year  (e.g. 95)         
  mm   is the month (e.g. 01 for January)         
  dd     is the day  (e.g.  25) 
 
For example, if the date was 25 January 1997, MFJCom for Windows would suggest the 
name:        
  SR970125.SKY 
 

You can choose a different name, or you can choose to add the captured data to a file that 
already exists on your disk. Click OK or Cancel when you have chosen a name. 
The following form will then be displayed: 
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Click  "Plain text only" to save "printable" text (no control codes will be saved).Click "Binary" 
to save everything received from the TNC. 
 
If you choose Plain text only, the file is in "text" format, and can be read by any text editor, 
including Windows Notepad. Rows of "VVVVVVV"  in the file separate data saved at different 
times on the same day. 
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9. Controlling More than One TNC at the Same Time 
Windows is a multitasking operating system. That means you can control more than one TNC with 
a single computer. All you need to do is: 
 
1. Install MFJCom for Windows a second time. This time, you need to install it in  a different 

directory of your choice (not the one that the Setup program suggests for you). 
  
2. Connect the second TNC to a different serial port. 
  
3. Run the second copy of MFJCom for Windows. When it starts up, click on the Options menu 

to tell MFJCom for Windows which serial port it should be using. Input your call and other 
information, too. 

 
Simply run both copies that you’ve installed to control two TNC’s at the same time! 
 
There are some important things to consider about serial ports when running two copies of 
MFJCom for Windows: 
 

• you will get best performance if your serial ports use ‘16550’ type chips. Older ‘8250’ 
chips will work fine, though. 

  
• each copy of MFJCom for Windows must be connected to a different “Com” port. 
  
• each Com port must have a different IRQ. Refer to your serial card or computer 

manual to see how to set the IRQ. This may involve opening your computer and 
changing jumpers or DIP switches. Be CAREFUL when doing this. 

  
• the mouse must have a different IRQ than either of the Com ports connected to your 

TNCs (i.e. there must be unique IRQ settings for the mouse, TNC #1 and TNC #2). 
 
If you do not do this, you may get very poor response times when operating more than one TNC at 
the same time. 
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